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Course Overview  
In these exercises you will learn how to place Horizontal and Vertical Alignments.  This guide will 
not document each tool that is available on the OpenRoads interface. See the online help for 
commands not detailed in this document. 
 

OpenRoads Designer CONNECT Edition Help 
 

Skills Taught 
• Select the proper seed file to create a Base Model 
• Align a file so it’s in the proper geospatial location 
• Horizontal Centerline Layout 
• Horizontal Alignment Annotation 
• Vertical Profile Creation 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v9/en/GUID-1B18BC16-7361-4DA1-BC57-D8A9EEF3F9E7.html
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Exercise 1 - Creating a Base Model Geometry File 
This section instructs users how to create an alignment base model design file for a project. The 
alignment base model file will reside within the project folder structure 
the ...\Highways\Base_Models folder. Depending on the complexity of the project one or more 
alignment files can be created.  Horizontal alignments and vertical alignments (profiles) are 
stored in the alignment DGN file(s). References files such as survey and terrain files are attached 
without nesting. 

1.1 Startup 
Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey data, 
you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley Connect licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password.If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen. Click on the Connection Client Icon and select Open. 

     
Figure 1 CONNECTION Client System tray 
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5. Launch the Application. 
• Consultants 

Start the software via an appropriate CTDOT DDE icon 
• CTDOT employees 

On your desktop double click on the CAD Accounting icon. 

6. On the CT DOT Accounting Menu there will be select Compass OpenRoads CE 
In the Run Program field select the needed program, the Available Account (funding 
source) and Resource Type. Click on the Start button to load the program. 

 
Figure 2 CAD Accounting dialog box   
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7. After launching the program, a Welcome Screen for OpenRoads Designer will appear.   

8. Select Custom Configuration, using the small drop-down arrows select the 
Workspace CT_Workspace, the needed WorkSet and Role.   

Note: If you do not see the Project Number listed under Workset, please request a 
Compass/CAD Setup using this link  New CAD Project Request 

 
Figure 3 

https://ctdotcompass.atlassian.net/servicedesk/customer/portal/8/group/24/create/100
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1.2 Creating a New File 

1. Select the New File icon. Create a DGN file from the civil 2D seed and save it to the 
Base_Models folder. Use the file-naming conventions as described in Volume 16. 
Example: HW_CB_1234_1234_Alignments01.dgn 

 

2. On the New dialog box click the Browse button to select the proper seed file. 
 …CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 
 

 
Figure 4 New File 

Warning: Do not copy DGN files created with V8i SELECTseries or InRoads SS2, SS3, SS4, 
or SS10 to the new CTDOT CONNECT Project/WorkSet folders.  



Volume 3.1 - OpenRoads Designer Alignments 

8 
 

3. After the DGN file is created open File Explorer and browse to the file, right click hold and 
select View online. 

  
Figure 5 File Explorer View online tool 

4. The Projects SharePoint site will open, sort by Date, click on the three dots, select More > 
Check Out.  
Note: When you are done working on the DGN file, exit the program and go back to the 
SharePoint Site and Check In the file. 

 
Figure 6 SharePoint Check out 
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1.3 Referencing 

1. Reference in the survey and terrain file(s) using no nesting. Turn off levels as needed.  

2. TIP: ‘Save Settings’ when all levels are turned off as needed. 

3. Activate the terrain by clicking on the terrain boundary, hover over the boundary and from 
the pop-up menu select/click the Set Terrain Active tool.  

4. Click again on the terrain boundary and set the override symbology to Yes. Then to help 
with the horizontal alignment creation, you can turn on the contours.  Save Settings. 

 
Figure 7 

5. Review the file and Save Settings.  
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Exercise 2 - OpenRoads Review 

2.1 General Tools and Interface 

2.1.1 Tools 

Tools can be accessed a variety of ways, including the Ribbon, Search and Context 
Sensitive Menus. Ribbons are arranged by Workflows, which are selected from a pull-down 
in the upper left corner of the software. 
 
To activate the OpenRoads Modeling workflow use the pick list in the upper left corner if it is 
not already active. 

 
Figure 8 

The ribbon menu will reflect the OpenRoads Modeling tools. The tools are organized into 
categories on the ribbon tabs. 

• Home - Common tools such as Attributes, Explorer, Attach Reference Tools, Models 
and Level Display. 

• Terrain - Terrain modeling tools. 
• Geometry - Civil AccuDraw and geometry tools. 
• Site Layout - Parking, pad, pathway, vertical geometry and grading site design tools  
• Corridors - Superelevation and corridor modeling tools. 
• Model Detailing - Civil Cells and 3D tools (Linear Templates, Surface Templates, etc.). 
• Drawing Production - Saved views, notes, text, annotations, and plans production 

(cross section, plan, and profile) tools. 
• Drawing - Commonly used MicroStation drawing tools. 
• View - Commonly used view control tools. 

 
A Search Ribbon tool is also available at the right side of the title bar. Use it to find tools 
across the multiple ribbons. When you are not sure where to find a tool, simply type the 
command in the Search Ribbon field and a search will be performed across all ribbon 
menus. 
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2.1.2 Models and Views 

“Real World” Civil Engineering starts with a horizontal plane and a set of engineering rules. 
Vertical design follows the horizontal paths and follows a different path when it come to 
rules. For example, horizontal geometry typically uses circular arcs, vertical geometry 
commonly uses parabolas. Combine the two geometries to get 3D results. 
 
Some OpenRoads dgn’s have a single 2D or 3D models, but many design files have Multiple 
Models. 
 
The old InRoads software used an “external” proprietary file (.alg) to store geometry data. 
OpenRoads Designer exclusively uses the .dgn format (no external files) to store geometry 
data, the software stores geometry types in different models within a .dgn file. 

• Horizontal Geometry is stored in the default 2D Model. 
• Vertical Geometry is stored in a Profile Model view and associated to the horizontal 

geometry. 
 
Note: If a horizontal element has vertical information - one or more Profiles - then it “owns” 
a single Profile Model containing all its profile information. Profile Models are visible only by 
using the View Profile Model tool). 
 
Many design files contain a 2D and 3D Model, typically named Default and Default-3D, 
respectively. 3D Elements are created, managed and stored in the default 3D Model. 
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2.1.3 View Control 

In OpenRoads Designer CONNECT Edition, an enhanced right-click view control option has 
been added. 

• Enables quick display of multiple views in one model including plan, 3D, dynamic 
profiles, dynamic cross sections and superelevation. 

• The “1 View” option will reset a view back to default if accidently set to a dynamic 
cross section or profile view. 

• When selecting a dynamic profile or cross section view, the grid will be turned on for 
the view.  

• Right Click in the View 1 Window and select the desired preset View Control window 
set-up.  

After Selecting the desired tool select Save Settings. 
 

 
Figure 9 
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2.1.4 Multi-Model View 

Using the View Control tools creates a Multi-Model View. This can also be done manually. 
Open two views, on the View Attributes dialog box set View 1 to Default and View 2 to 
Default-3D. The active model will display both models in two separate views. Issue a Save 
Settings before moving on.   

 

 
Figure 10 

2.1.5 Switching Between Models 

Use the Set Active View Group tool to move between Models in your DGN file. 
 

 
Figure 11 
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2.2 Geometry Tools 

2.2.1 Feature Naming 

The OpenRoads Geometry commands are selected from the Geometry tab of 
the OpenRoads Modeling workflow. The commands are separated into four main 
categories, General Tools, Horizontal, Vertical and Common Tools as shown below. 

  

 
 

As civil geometry elements are placed, each element is given a feature name. The Name 
field displays the seed name that has been assigned to the selected feature definition. 

In the example at below, the Complex By PI command has been selected. The Centerline 
feature definition has a seed Name prefix of CL defined. If the name value is not changed, 
the software will automatically increment the name of each line placed. For example, the 
first line placed is named “CL”, the second is named “CL1”, etc., is it recommended to give a 
short descripted name as shown below. 
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The element name can be reviewed by using the Select Element tool and floating the 
cursor over the element as shown below (you do not need to select the element). 

 

The Feature Definition and Feature Name for a selected element can be edited in the 
Properties dialog as shown below. 
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2.2.2 Feature Definition Toggle Bar 

The Feature Definition Toggle Bar is accessed from the ribbon by selecting OpenRoads 
Modeling > Geometry > Standards > Feature Definition Toolbar. 

 

Toggle on the first icon to automatically assign the selected feature as the active feature as 
you use various OpenRoads Geometry commands. 

In the example below, the Line Between Points command is selected. The Feature 
Definition is defined by the active feature selected in the Feature Definition Toggle Bar. 

 

2.2.3 Centerlines 

Standard centerlines will use the following Feature Definition: 
• Centerlines: Alignment/Center/Centerline 
• Driveway Centerlines: Alignment/Center/Driveway 
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Miscellaneous alignment feature definitions are available if needed for out of the ordinary 
circumstances. 

2.2.4 Non-Centerline Roadway Geometry 

Non Centerlines Geometry can be placed with any of the Horizontal tools. 

 

These feature definitions can be found in the liner/Roadway Geometry folder. 
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Feature Definitions are further broken down into folders for: 

• Placing Right of Way lines 

• Placing Watercourses 

• Placing Structure Outlines 

• Importing Existing Warning: Currently OpenRoads Terrains and Survey Features do not 
have the same functionality as InRoads.  With InRoads existing linear features in a DTM 
could be displayed as a crossing feature on cross section sheets.  This is not available with 
OpenRoads, crossing features will need to be brought in as a Geometry Feature in order to 
be displayed on Cross Sections.  Bentley Recommends using the 3D by Plan Profile tool to 
recreate the needed crossing features. 

  

2.2.5 Existing Features 

For a quick overview on Importing Existing Features watch this video of a Wetland Line being 
placed over the Existing Survey Feature. 

 

 

https://portal.ct.gov/dot/-/media/dot/documents/aec/cad_connect-dde/volume-3/wetlands-on-xsc.mp4?sc_lang=en&rev=6bfa9fe9ecba4d6082a6b7646753073b&hash=B737E151F46187E896E4BD989BEB699D
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2.2.6 Civil Accudraw 

Placing elements in a 2D model is like manual drafting — all elements appear on the same 
plane, the sheet of paper.  

• In 3D, you place elements in space — horizontally (for example, a floor), vertically (for 
example, a wall), or at any other angle or direction (for example, a sloping roof).  

• By default, data points in a 3D model are placed at the view's Active Depth. Where 
you snap a tentative point or place a data point in a blank part of a view, it will be 
located at the active depth. You can, however, snap a tentative point to an existing 
element at any depth in a view. When you accept such tentative points, the data 
point is placed at the level of the snap point. 

Civil AccuDraw and its drawing plane let you place elements away from the active depth. 
Often this improves productivity, since you need not constantly change the active depth. 

Civil Accudraw is activated by selecting the Civil Accudraw icon from the Geometry tab as 
shown below. 

  

 
  

The first icon is used to turn Civil AccuDraw on or off. 

 
  

Civil AccuDraw performs many of the same functions as MicroStation AccuDraw but has 
greatly expanded capabilities for the civil designer. 
Warning: Simultaneous use of Civil AccuDraw and MicroStation AccuDraw will cause 
errors.  Close MicroStation AccuDraw when using Civil AccuDraw. 
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2.2.6.1 Civil AccuDraw Settings  
Civil AccuDraw Settings are accessed by selecting second icon as shown below. 

    

Auto Load – Toggle this option ON to automatically load Civil AccuDraw. 

Floating Origin - CTDOT recommends turning this option off. 
ON: the origin moves to the last point placed. OFF: the origin remains fixed. 

Context Sensitivity - CTDOT recommends turning this option off. 
ON: the compass rotates in response to the context of various tools.  

Smart Key-Ins - 
ON: Civil AccuDraw interprets a number as positive or negative, depending on the direction 
of the pointer from the compass. 
XY ordinates only: Smart Key-ins cause Civil AccuDraw to move the focus to either the x or 
the y field depending on the pointer position.  

Preserve Method Locks - 
ON: the locked values remain locked after switching the ordinate methods.  For example, 
using station-offset ordinates and a lock station of 1+00, switch to distance-direction 
ordinates.  Station 1+00 will remain locked while inputting distance-direction.  The resulting 
effect will be a distance-direction-stationlock.  

Sticky Z Lock - 
ON: inputs to Z ordinates remain locked (sticky) until they are changed.  This is useful in a 
3D DGN to control the Z ordinate.  For example, input 100.00 for the Z ordinate and the value 
remains constant until changed.  
OFF: The Z ordinate follows the cursor dynamics.  
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This also controls whether the origin for delta Z measurements follows the XY origin or is 
independent of XY.  
ON: the origin for delta Z is completely independent of the XY origin.  For example, the user 
can set the origin for dXdY measurements from point A and set dZ to be measured from a 
second point B.  The Z origin does not change until reset by the user.  The effect will be 
apparent when drawing a linestring.  When drawing a linestring, the dynamic orientation of 
the compass will adjust to align with the most recent line segment.  The Z origin will remain 
fixed wherever the user placed it at in the beginning.  
Note: When Accudraw ordinates are set to X,Y the sticky Z toggle does not apply.  This is 
because, by definition, XY mode is always assumed to be absolute.  

Always Show Compass - 
ON: the compass is always visible.  
OFF: the compass is only visible when the appropriate input is required. 
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2.2.6.2 Civil AccuDraw Tools 
Hold down the second icon to reveal the shortcut menu shown below. 

  

2.2.6.3 XY Tool 
When the XY mode is selected and a civil command is active, the coordinates of the 
current cursor position are displayed in a floating dialog as shown below. 

       

The Tab key is used to move through the key-in fields in the dialog. 
Values entered in the floating dialog are locked when the Enter key is pushed. 
To unlock a value, tab to the field and push the End key. 
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2.2.6.4 Civil AccuDraw Compass and Curser Input 

When the Always Show Compass setting is toggled on, a compass is displayed at 
AccuDraw’s origin point when Civil AccuDraw is active. 

The compass is always circular and is marked by a number of tics.  The default is 4 
compass points which can be changed in the settings. 

 

The north arrow on the compass will always point to north as defined by selecting File > 
Settings > File > Design File Settings > Angle Readout. 

If the Civil AccuDraw Settings dialog (shown above) has the Context Sensitive option 
turned on (default), then the compass auto-rotates in a similar fashion to MicroStation 
AccuDraw: 

 

• The Distance-Direction ordinate is used to enter points in polar coordinates as 
shown above. 

• The input for angle and direction fields follows the File > Settings File > Design File 
Settings > Angle Readout settings. 

• Note that rather than direction being shown, the label and value are now an 
Angle.  This is because the context is based on the direction of the preceding line 
segment rather than an absolute direction. 

• The compass can be rotated with the V, B, T, RQ, RE shortcuts.  

• V rotates the drawing plane to align with the view axes. 

• T rotates the drawing plane to align with the axes in a standard Top view. 

• RQ is used to quickly and temporarily rotate the drawing plane. 

• RE rotates the drawing plane to match the orientation of a selected element. 

• Use the T (Top) shortcut or the corresponding drop-down to return to a pure 
direction.  
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2.2.6.5 Station Off-set 
The Station-Offset ordinate is used with a reference element to enter information as a 
station and offset relative to a selected element. 

  

The reference element can be a MicroStation element or an ORD Geometry element. If a 
MicroStation element is selected, the beginning of the element is assumed to be station 
0+00. If a civil element is selected with stationing defined, the station value of the selected 
element is used. 

Take the following steps to select the reference element with the Station-Offset ordinate 
active: 

• Tab to activate the Offset field that is floating on the cursor 
• Enter the letter “O” shortcut to set the origin. You are prompted to select the reference 

element. 

Once selected, data can be entered using station and offset values relative to the 
reference element as shown above. 

 
 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v9/en/GUID-0EE5C4C5-C12D-4892-A491-0CFCD25BEF50.html
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v9/en/GUID-0EE5C4C5-C12D-4892-A491-0CFCD25BEF50.html
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2.2.7 Geometry Rules 

Civil Geometry elements drawn using the OpenRoads tools are “ruled” graphics that 
behave according to the geometric rules that define how the element was placed. 

 

For example, a line drawn using the Line Between Points command has the following 
rules: Distance and Line Direction as shown below. 

These parameters can be entered in the Tool Settings dialog, shown at right above, or by 
using the parameters floating on the cursor. 

If you use the input field that floats on the cursor, the left and right arrow keys are used to 
switch between multiple parameters. 

When a parameter value is entered, it is locked as shown below. The parameter can be 
unlocked by unchecking the item in the Tool Settings dialog, or by pressing the End key on 
the keyboard while the parameter value on the cursor has the keyboard focus. 
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After a parameter value has been keyed in, use the left and right arrow keys, or the Tool 
Settings dialog to enter values for the remaining parameters.  

Issue a data point (left-click) to place the element. 

The rules can be reviewed and edited by using the MicroStation Element Selection tool to 
select the element. In the example below, the rules for the selected line are displayed. 

  

The rules can be edited by left-clicking on one of the parameters as shown below. 

 

The rules for the selected element can also be reviewed and edited in the Properties dialog 
as shown below. 

  



Volume 3.1 - OpenRoads Designer Alignments 

27 
 

MicroStation’s Manipulate commands (Copy, Scale, Rotate, etc.) cannot be used on ruled 
geometry. The rule must be removed to use these commands. 

To remove a rule, select the element and let the cursor rest on the selected element until the 
pop-up menu appears. Choose the Rules menu as shown below. 

The following options are provided: 

• Lock - Deactivate Rules 
• Remove Rule 
• Unlock - Activate Referencing Rules 
• Lock - Deactivate Reference Rules 
• Remove Rule 
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2.2.8 Element Manipulators 

OpenRoads Geometry elements have Manipulators that are displayed in MicroStation 
when an element is selected. These manipulators can be used to edit the selected element 
graphically or by entering a value. 

Clicking on one of the key-point manipulators will display direction arrows to edit the line, 
as shown on the example below. 

 

Tip: The size and color of the Manipulator Text can be adjusted in the User Preferences. 
From the MicroStation menu, select File > Settings > User  > Preferences and then choose 
the View Options – Civil item on the left side of the dialog. The Manipulator Size or 
the Manipulator Font Scale parameters can be used to adjust the text size. 
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2.2.9 Design Intent 

As geometric elements are drawn in MicroStation using the OpenRoads Horizontal 
Geometry tools, the software retains information about not only what element was drawn, 
but how it was drawn. This is referred to as the Design Intent. 

In the example below, the horizontal line was drawn first. The second line was drawn using 
the Perpendicular snap to draw the line at a perpendicular form the horizontal line to a 
specific ending point. 

 

If the horizontal line is modified by changing the direction of the line, the design intent for 
the perpendicular line is preserved. The Perpendicular rule, and the ending location are 
preserved as shown below.  
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2.2.10 Snaps 

As geometry elements are placed in the design, the elements are “ruled” to one another 
using snaps. 

The most common snap is the Key Point snap. In the example below, the second line was 
placed using a Key Point snap. When the line is selected, the icon for the snap mode that 
was used is displayed. 

If the first line is modified, the second line will maintain its relationship to the first line 
according to the Key Point snap rule.  

 

Occasionally you may wish to create civil geometry elements that are not “ruled” to other 
elements. Turn off the Persist Snaps icon on the Feature Definition Toggle Bar to place civil 
geometry elements by snapping to other geometry without creating a rule. 

 

2.2.11 Editing Dynamic Text 

When a civil geometry element is selected, and the various rules are displayed, some rules 
are shown in grey and cannot be edited by left-clicking on the text. To edit these rules, you 
must select the underlying geometry directly. 
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Take the following steps to select the underlying element. 

Use the MicroStation Element Selection tool to select the geometry element • Right-click on 
the element that you wish to edit. 

The underlying element is selected, and the associated rules can be edited as shown 
below. 

 

2.2.12 Deactivating Rules 

Geometry elements that have active rules can be selected, edited, and deleted at any time. 
Deactivating the rules will lock the element in place so that it cannot be edited or deleted 
unless the rules are reactivated. This is useful to lock an alignment in place once the design 
has been completed. 

 

To deactivate the rules on a given element, select the element and let the cursor rest on the 
element until the pop-up menu appears. Choose the Lock – Deactivate Rule option as 
shown below. 
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2.3 Design Standards 

Design Standards are used to monitor various alignment parameters on OpenRoads geometry 
elements. The standards are stored in DGN Libraries in the following location: 

...\CT_Configuration\Organization-Civil\_CT_Civil Standards - Imperial\Dgnlib\Design 
Standards 

The design standards can be used for two purposes: 

• Provide default values for element creation tools such as radius of a curve for a selected 
CTDOT standard. 

• Check and report on the compliance of a geometric element with the design standard 
that has been assigned to the element. 

When a design standard is violated, the user is notified in two ways: 

• An icon is displayed on the graphics to indicate that there is a problem. 

• The Civil Message Center reports any errors. 

The Design Standards Toolbar allows you to select and apply a design standard. From the 
OpenRoads Modeling Geometry tab, select Standards > Design Standards Toolbar to access 
the dialog shown below. Design Standards can also be applied to an element after it has been 
created by using the Set Design Standard icon on the Design Standards Toolbar. 

 

The toolbar contains a drop-down list to select the design standards and the design speed. 
The vertical design standard, displayed in the drop-down menu to the right, is automatically 
set when the horizontal design standards is selected. 
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There are two icons located to the left of the drop-down menus. The first, Set Design Standard, 
is used to apply the current design standard to selected geometric elements. The 
second, Toggle Active Design Standard, is used to set the selected design standards active for 
relevant commands. 
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2.4 Complex Geometry 

Individual civil geometry elements are connected together as a single entity using 
the Complex By Element command. 

Select Geometry > Complex Geometry > Complex By Element to access the command.  

 
In the example above, the Feature Definition is set to Use Active Feature as defined in 
the Feature Definition Toggle Bar.  

When the Method is set to Automatic, the software will automatically select elements to make 
up the complex geometry by searching for elements with endpoints that connect within 
the Maximum Gap value. If a fork is found, where two elements are found within the Maximum 
Gap tolerance, the user is prompted to identify which path to accept to compete the 
operation. 

Be sure to enter a Name for the geometry. 

When locating the starting element an arrow is displayed defining the direction to store the 
element. Complex elements can be stored in the opposite direction than they were originally 
defined by selecting the other end of the graphics.  
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2.5 Start Station 
When an OpenRoads alignment is stored, the software assumes a beginning station value of 
0+00. The station can be redefined by use of the Start Station command. 

   

The command has two parameters: 

• Start Distance The distance along the alignment to assign the Start Station. The 
beginning station is computed based on the Start Distance and the Start Station value. 

• Start Station The station value to be assigned at the Start Distance location. 

After the beginning station has been defined, selecting the alignment will display the station 
rules as shown below. 
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2.6 Station Equations 
The station parameters can be edited by selecting the rule in the design file, or from the 
Properties dialog. Add Station Equation - The Add Station Equation command, located below 
the Start Station command, adds parameters for the Ahead Station and Back Station. 
When the command is selected, the user is prompted to select the alignment to assign the 
station equation. 

After the alignment has been selected, the location of the equation can be identified 
graphically, or by keying in the Back Station value. 

 

The ahead station is stored as a “region” much like the legacy GEOPAK format. When 
the Ahead Station value is entered, it is not necessary to define the region number. 

 

The station equation value can be reviewed and edited by selecting the element as shown 
below. The parameters can also be edited in the Properties dialog. 
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2.7 Interface Setup 

1. If not already docked, from the Geometry ribbon select the General Tools tool, select and 
dock the Design Standards Toolbar and the Feature Definition Toolbar. These tools can be 
used to better adhere to design standards. 

 

2. From the Design Standards Toolbar: select the AASHTO Design Standards for the project 
design as needed, example: 6% Super (2 Lane AASHTO Design Standards 2018 – Imperial 
Design Library) – 35 MPH (2 Lane AASHTO Design Standards 2018 – Imperial Design Library) 
and Stopping Sight Distance (AASHTO Design Standards 2018 – Imperial Design Library). 
Turn on the Toggle Active Design Standard.  

3. From the Feature Definition Toolbar: select the active feature definition for Alignment - 
Center – Centerline and Lock the feature definition. Activate the Chain Command, this will 
chain the tangents together, but still remain individual elements. 
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Exercise 3 - Horizontal Alignements 

3.1  Creating Alignments 
In this module the creation of a horizontal alignment with the PI method will be described. 
There are several methods to create horizontal alignments for more on other methods or other 
alignment tools please see Bentley's OpenRoads Help – Horizontal Geometry. 

1. From the Horizontal tool group select the Lines – Line Between Points tool. In 
the Line toolbox, Feature Definition should be set to: Use Active Feature, this should be 
greyed out, and it will set the feature tangent line to the active feature definition picked in 
the previous step. In ‘View 1, Default’ select the first PI location. Follow the command 
prompts attached at the cursor or at the bottom left – Enter Start Point. Example: At the left 
beginning, at about the middle of the existing roadway – left click.  Enter End Point. 
Example: somewhere close to the intersection – left click. 
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2. Because the Chain Command was activated, it prompts Enter End Point. Select a point for 
the next PI, again it prompts Enter End Point.  Select the end of the horizontal 
alignment. Right-click to end selecting a new end point, select the Element Section tool to 
end and get out of the place line command. 

  

3. Four PI locations have been established with tangents shown. Turn Off the contours for the 
terrain. 

 

4. To place a curve (arc) between two tangents select the Arcs – Arc Between Elements – 
Simple Arc tool. The Simple Arc toolbox opens. The Feature Definition should be set to Use 
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Active Feature. With the Design Standards active the radius is set to the value for the 
design speed, example: Radius – 654.000’. Now follow the command prompts. Locate First 
Element – select the first tangent; Locate Second Element – select second tangent; Select 
Construction Sector with locked Radius 654.00’ – datapoint to select the construction 
sector; Trim/Extend Option – choose Both and datapoint (left-click) to accept.   

  

5. Repeat this for the next curve (arc). 

 

6. Review the Horizontal Curves. The radii can be adjusted, if the radius doesn’t comply with 
the design standard an advisory marker will be placed on the radius.  
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NOTE:  You still can keep this radius value, just be aware this is not to design standards 
picked for the alignment. The design standards tools do not have to be used when 
designing the alignments, the tools are design aides. 

7. Complex the horizontal alignment, turn the individual elements into one complex line-
string. Select the Complex Geometry – Complex By Element tool. 

The Create Complex Element toolbox opens, set the following: 

• Method select either: Automatic or Manual, example: Automatic. 
• Maximum Gap set to 0.033 (max. distance between elements that will be 

complexed). 
• Feature Definition is set to Use Active features if feature definition is locked or set to 

as example: Centerline. 
• Name type a name for the horizontal alignment, example: RTE A 

 

Follow the prompts: Select First Element – select the beginning of the first tangent, an 
arrow should appear showing the direction of the alignment. Left Click to accept direction. 
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All of the horizontal alignment should be highlighted/selected. Left Click again to Accept 
Complex. 
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3.2 Adjustments 

3.2.1  Adjustments to the Horizontal Alignment 

Depending on the Design Intent, the placement and relationship between the elements will 
control how individual elements of the horizontal alignment can be modified. 

For more information on placements and relationship of elements see Bentley's OpenRoads 
Help. 

In the example the PI method was used, this will allow for modifications to the PI locations 
and the radii of curves. 

3.2.2 Adjustment to PI Location and Radii of Curves 

1. Using the Element Selection tool click on the horizontal alignment; the horizontal 
alignment is highlighted and all features of it will be visible.  

2. Select the Second PI location and move it to a new location; see the horizontal 
alignment move. Move the PI to the new location. 

3. Move the third PI location. Select the third PI and move the PI to the new location, 
move the alignment to better fit with the existing roadway. 

4. Now adjust the radius for a better fit.  Increase the first radius to 800 feet, see 
what happens. Click on the radius, this will activate the radius components that 
can be adjusted. Click on the radius (orange text) a box with the radius will 
appear, here change the radius to 800.00’. Press Enter.   Review the arc, click 
again on the radius and type in 700.00 feet as radius. Click on the second 
radius, enter a new radius of 400 feet. Press Enter. We will leave this radius to 
better match in with the existing curve. You can see there is now an exclamation 
icon, meaning the design standards are not met. 

These are just a few of the options to control and edit horizontal alignments, 
see Bentley's OpenRoads Help for more detailed edit options. 
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3.3 Define Start Station for Horizontal Alignment 
The Start Station assigns stationing to an element. A station value and a position along the 
element for that station value are assigned. If no station value is assigned, then the beginning 
station is assumed to be zero (0+00.00). 

1. In the Horizontal toolbar click on the Modify tools – select the Start Station tool. 

2. Follow the prompts: Locate Element, select the beginning of the alignment. Start Station 
Position, enter 0.00 as Start Distance. Enter Starting Station, enter Start Station 100+00.00 
and click within the view. 

3. Click on the alignment, it will now display the start station and the offset. 

NOTE: Any changes to the alignment will also update the Stationing. 
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3.4 Horizontal Alignment Annotation 

3.4.1 Annotation Groups 

Alignment elements are assigned a Feature Definition, which controls the symbology of the 
element (level, color, line style, and line weight) as well as the annotation properties of the 
element. The CTDOT Standards include feature definitions for alignments, which can be 
reviewed from the Project Explorer dialog, as shown below. 

There are several levels of configuration that has been set to get the annotation to display 
to CTDOT standards.  
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Note: the alignment feature definition controls the symbology and annotation settings for 
both the horizontal geometry and the proposed vertical alignment. 

3.4.2 Annotation Tools 

When geometric alignments are placed in the file, the annotation is not automatically 
generated by the software. The user must identify the alignments that are to be annotated 
either individually, by selecting the specific alignments, or by annotating all of the 
alignments contained in the active model, or all models in the active file. 

Annotation commands are selected from the OpenRoads Modeling WorkFlow in 
the Drawing Production tab, as shown below. 

 

Element Annotation 
Individual elements are annotated by selecting the Element Annotation command from the 
Drawing Production tab. Two commands are available as shown below. 
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3.4.3 Annotation Element 

The Annotate Element command is used to annotate one of more selected elements. The 
command prompts to select the OpenRoads element to be annotated. Multiple elements 
can be selected. Reset (right-click) to complete the selection process and initiate the 
annotation placement.  An example of annotation at the beginning of an alignment is 
shown below. 
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The Remove Element Annotations command is used to remove the annotation from 
selected elements. When prompted, select the elements to remove the annotation. Reset 
(right-click) to end the selection process and initiate the removal process. 

3.4.4 Model Annotation 

The Model Annotation command us used to annotate all of the elements in the active 
model, or all models, by selecting a specific Annotation Group. Two options are available as 
shown below. 

 

  

ANNOTATE MODEL - Select this command to annotate all the elements in a model, or in all 
models, by selecting a specific Annotation Group. When the command is selected, the user 
is prompted as shown below. Issue a data point (left mouse-click) to initiate the process. 

 

  

REMOVE MODEL ANNOTATIONS - Select this command to remove all annotations from the 
active model or all models in the active file. 

A Horizontal Alignment needs the following annotation: 

• Stationing, 
• PC’s, PI’s, PT’s, 
• Curve Data and 
• Bearings 

This has been automated; the annotation will be in the design file (alignment dgn-file) 
and can be done after the alignment is created. Some text adjustments to location of PC, 
PI, PT, curve data and bearings can be made, but this should be done sparingly if at all. If 
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adjustments to the alignment are made, the text will also adjust to original text 
location/placement. 

Example: Horizontal Alignment for RTE A (normal annotation) and Private Road (small 
annotation), see below. 

 

1. Open the alignment file (this file should reside in the Base_Model folder), if not already 
open. Select the OpenRoads Modeling workflow or the OpenRoads Drawing 
Production workflow. 

 

2. Click on Drawing Production tab. These annotations tools are available: Annotate 
Element (for single element), Remove Element Annotation, Model Annotation (for multiple 
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elements) and Remove Model Annotation. As an example, we will use Annotate 
Element tool. 

 

3. Click the Annotate Element tool, follow the prompts. Locate Elements – Reset To Complete. 
Click on the alignment (example: SR 14), after it is highlighted, right-click to Reset. 

 

4. The alignment is now annotated/labeled.  
5. For alignments using Centerline, Centerline – Green and Centerline – Pink the stationing 

will be every 50ft.  
6. For alignments using Centerline – Small Blue and Driveway the stationing will be every 10 

ft. 
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7. To remove annotation, use the Remove Element Annotation tool, follow the 
prompts. Locate Elements – Reset To Complete. Click on the alignment, after it is 
highlighted, right-click to Reset. The annotation is removed. 
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3.5 Horizontal Reports 
Several preconfigured reports are provided with the OpenRoads software that can be used to 
review alignment information. 
Various reports can be accessed from the Home tab, as shown below. 

 

Additionally, reports can be generated by selecting a civil geometry element and choosing the 
Reports icon from the pop-up menu. 

 

When a report is generated, the default report for the element type is displayed. The example 
below shows the default report for an alignment. 
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Several reports are available and can be selected from the list at left. Depending on the 
element type that the selected report has been configured to accept, it may not show any 
information. 

The format of the report can be modified by selecting Tools > Format Options. The dialog 
below is opened. 
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The format options are stored as a user setting in the Windows Registry and must be 
manually set by each user on their computer. The settings shown above are recommended 
for CTDOT projects. Changes made to the Format Options dialog are dynamically applied to 
the current report when the dialog is closed.  

Reports can be saved in various formats using the File > Save As... command from the main 
Report Browser dialog. 
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Exercise 4 - Profiles 
In this module the creation of a vertical alignment (proposed profile) with the PI method will be 
described. There are several methods to create vertical alignments for more on other methods or 
other alignment tools please see the Bentley's OpenRoads Help – Vertical Geometry. 

OpenRoads Designer stores vertical alignments as a component of the horizontal alignment in the 
same design file as the horizontal geometry. This is true for both existing vertical alignments, 
which are extracted from an OpenRoads Terrain Model, and proposed vertical alignments. 

Although the vertical geometry is stored in the design file, the graphical display of the vertical 
alignment information is not plotted in the design file. Vertical alignments are displayed in a 
profile window for review and editing. 

Vertical geometry tools are accessed from the Geometry tab of the OpenRoads 
Modeling workflow, as shown below. 

 

4.1 Profile Settings 
The Design File settings contain parameters for formats as you work with vertical 
alignments. Select File > Settings > File > Design File Settings and then click the Civil 
Formatting item from the list on the left of the dialog. The Profile Settings are set to the values 
shown below in the CTDOT seed files. 
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4.2 Existing Ground Profiles 
Existing ground profiles are extracted along the selected civil geometry element from the 
active terrain model. The active terrain model is set by selecting the terrain element and 
choosing the Set As Active Terrain Model icon as shown below. 

 

To extract the existing profile, select the alignment graphics and let the cursor rest on the 
graphic element until the pop-up menu appears. Choose the Open Profile Model icon as 
shown below. 

 

You are prompted to select or open a view window to use for the profile display. Open a new 
view window and then left click in the view window to display the profile. An example is shown 
below. 

 

Note: The profile is displayed in the profile view for review and editing; however, the profile is 
not written to the design file. The selected view window is used as a temporary display of all 
the profiles associated with the selected alignment. The selected view window is not 
specifically associated with an alignment/profile and can be used to display the profiles from 
different geometric alignments as needed. 
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4.3 Profile Feature Definitions 

The symbology of vertical geometry is defined by Feature Definitions; however, the feature 
definition for profiles is not assigned by the user. Feature definitions for vertical alignments are 
defined as follows: 

• Existing vertical alignments inherit their display parameters from the feature definition 
that has been assigned to the terrain model that was used to extract the profile. 

• Proposed vertical alignments inherit their display parameters from the feature definition 
that has been assigned to the horizontal geometry that the vertical geometry is 
associated with. 

To help differentiate between the tangent lines and vertical curves, proposed profiles are 
defined to display the vertical curves with color 20, and tangent lines with color 1. 
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4.4 Creating Vertical Alignments 

1. There should be 2 view windows open: View 1, Default showing the survey, terrain and the 
horizontal alignment; View 2, Default-3D showing the terrain, there are no other 3D items. 
The 3D terrain should only have the Boundary turned on. 

 

2. If not already docked, from the Geometry ribbon select the General Tools tool and select 
and dock the Design Standards Toolbar and the Feature Definition Toolbar. These tools 
can be used to better adhere to design standards. 

3. Next open another view window (View 3 Default) for the profile view of the existing terrain at 
the horizontal alignment, a longitudinal cross section of the existing terrain at the centerline. 

4. In the horizontal view (View 1, Default) with the Element Selection tool select the Centerline 
(the horizontal alignment previously created). Example: RTE A.  
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5. Hover over the horizontal alignment for the context menu (pop-up menu) to come up and 
select the tool. Follow the prompts. Select the Open View (View 3, Default) window. Click 
within the view and the existing terrain profile will be shown (Terrain must be active).  

 

6. The view window’s name will also change, example: from View 3, View 3, Profile – RTE A.  

7. The Design Standards previously selected should still be active if previously activated. 
Example: 6% Super (2 Lane AASHTO Design Standards 2018 – Imperial Design Library) – 35 
MPH (2 Lane AASHTO Design Standards 2018 – Imperial Design Library) and Stopping Sight 
Distance (AASHTO Design Standards 2018 – Imperial Design Library). 

8. From the Feature Definition Toolbar: select the active feature definition for Alignment - 
Center – Centerline and Lock the feature definition. Activate the Chain Command, this will 
chain the tangents together, but still remain individual elements. 
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9. Next from the Vertical tool group select the Lines – Profile Line Between Points tool. In 
the Line toolbox, the Feature Definition should be set to: Use Active Feature, this should be 
greyed out, and it will set the feature tangent line to the active feature definition picked in 
the previous step. 

 

10. In "View 3, Profile – RTE A” (example) select the first PI location.  For VPI 1 (Vertical Point 
of Intersection) you can just click to the beginning of the existing profile, or you can 
use Civil Accudraw and to use Station and Elevation for the VPI method. Click on the Civil 
Accudraw icon bring the courser back into the view, now there is Station and ‘Z’ (for 
elevation) attached to the courser. Type in the Stationing (100+50.00) and hit the Tab key, 
the ‘Z’ value for elevation can be added or left blank. The view will now show a vertical red 
line at Station 100+50, snap to the beginning of the terrain and Accept (left click).  
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11. Move the courser and pick the next VPI (VPI 2) by Station, Elevation or Distance, example: 
Station: 109+50, hit the Tab key; you can enter the Elevation, or Tab again, enter a length, or 
use arrow key to enter a desired slope. 

 

12. Repeat this for VPI 3, example: Station: 115+50, Tab key, enter Elevation 79.00, Tab 
key. Click the left mouse button to accept and place the VPI. 

13. For the last VPI (VPI 4) click to the end of the existing profile or enter a Station, 
example: Station 117+80, tab (now station is locked) click on the existing profile to 
match in to.  Click the Right mouse button to stop the command and select the 
Element Selection tool to fully exit the command. 
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14. Review your vertical alignment (proposed profile). The Feature Definition Lock and 
the Design Standard Lock are still on (set).  Making it unnecessary to enter a Feature 
Definition. 

 

15. Next the vertical curves will be placed. Select the Curves – Profile Curve Between 
Elements – Parabola Between Elements tool. Follow the prompts.  Locate First 
Profile Element – click on the first tangent. Locate Second Profile Element – click on 
the second tangent. Next define the curve by entering the length, example: 300.00 
(feet). Accept (left-click), Trim/Extend use the arrow keys to go to 
Both, Tab key. Accept (left-click). Repeat these steps for the next curve. 
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16. Review the vertical alignment (proposed profile). Make adjustments if 
needed.  Using the Element Selection tool click on the first tangent, depending on 
the rules (relationships) with which the tangent was placed Length, Slope, Station 
and Elevation can be changed. The Length of Curve can be adjusted. 

17. Complex the vertical alignment, select Complex Geometry – Profile Complex By 
Elements. Set the following: Method to Automatic, Maximum Gap to 0.033. Feature 
Definition: Use Active Feature (greyed out – Feature Definition locked 
previously), Name: enter the alignment name – example: RTE A. Follow the 
prompts. Locate First Element.  Select the beginning of the vertical alignment, the 
entire alignment will highlight. Accept (left-click). 
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18. Set the profile active. Using the Element Selection tool, select the profile, from the 
pop-up menu select: Set As Active Profile. This will associate this profile with the 
horizontal alignment, and you can now see the alignment also in the 3D view (View 
2, Default-3D). Save Settings.  

 

 

The profile in the alignment dgn file is not annotated, for annotation of profiles see Volume 
13 

  

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Label%20%E2%80%93%20Profile%20(Vertical%20Alignment)
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